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 WORKSHOP DESCRIPTION 

Overview 
Need to create a list of  resources to other content on the Web?  Want to find out how to control 
the layout of  your Web site?  This Dreamweaver workshop teaches you how to take advantage 
of  the Web by adding hyperlinks and tables.  Hyperlinks – links for short – allow your Web 
visitors to connect to additional Web pages in your site or to other sites on the Web.  Tables help 
you arrange content and control spacing on your Web pages.  Topics include: creating hyperlinks 
for text and images, inserting an e-mail hyperlink, generating an anchor and an associated 
hyperlink on the same page, and inserting and modifying tables. 
 

Prerequisites 
Individuals taking this workshop should have a working knowledge of  Dreamweaver, browsers, 
the Web and the ability to effectively work in the Windows or Macintosh OS environment.  
Participants will be expected to know how to perform all skills taught in the Dreamweaver: 
Introduction to Editing Web Pages workshop with little assistance. 
 

Objectives 
Participants attending this workshop will: 

▪ Use Dreamweaver to: 
▫ Create hyperlinks for text and images. 
▫ Insert an e-mail hyperlink. 
▫ Generate an anchor and an associated hyperlink on the same page. 
▫ Insert and modify tables. 
▫ Use FTP to copy files to a Web account. 
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ADDING HYPERLINKS 
 
To take full advantage of  the Web, you need to add hyperlinks to your Web pages.  These links 
allow your visitors to navigate from one page to another in a non-linear fashion, searching for 
information that best suits him or her.  Here are a few ways to add hyperlinks. 

New Text Hyperlink 
step 1. Click inside your document where you want to place the hyperlink. 

step 2. Click the insert hyperlink button ( ) on the Objects (Insert) panel, and fill out 
the information in the Hyperlink window, such as text and link. 

 
 

Existing Text or Image Hyperlink 
step 1. Select the element in your document using one of  these methods: 

▪ Text: Click and drag using the mouse to highlight the desired text. 
▪ Image: Click the image. 

step 2. Select the file you want to link to by following one of  these methods: 
▪ Click the pointer icon  and drag the mouse pointer to the file in the Site panel. 
▪ Click the folder icon  and select your file from the Select File window. 
▪ Type the entire Web address in the space next to Link.  For example, 
http://www.csus.edu. 
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EXERCISE 1 Text and Image Hyperlinks 

1. If  you have not already done so, create a site using the dw-links-tables folder 
that you were given. 

2. Open the file technews.htm in Dreamweaver. 

3. Add a new text hyperlink in the left-side navigation area (before "Questions”) 
that links to the file sample_page1.htm.  Choose your own text for the link. 

4. Add a hyperlink to the text “special offers listed on the website” of  Sac State 
OneCard Discounts story that links to the Web address listed after it. 

5. Save your work and preview your changes in a Web browser. 

 

New Text E-mail Hyperlink 
step 1. Click inside your document in the Design view where you want to place the text e-

mail hyperlink. 
step 2. Click the insert e-mail link button  on the Objects (Insert) panel, and fill out 

the information on the following window. 
 

 
 

Existing Text E-mail Hyperlink 
step 1. Click and drag using the mouse to highlight the desired text. 
step 2. In the Properties panel type the e-mail address in the space next to Link. When 

creating an e-mail hyperlink, your link value should be similar to 
mailto:me@csus.edu, where you replace me@csus.edu with an e-mail 
address.  The mailto:text is required to make this an e-mail hyperlink. 
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The Named Anchor – Hyperlink to a Specified Position on a Web Page 
Named anchors let you set markers in a Web page, which are often placed at a specific topic 
within a Web page.  You can then create links to these named anchors, which quickly take your 
visitor to the specified position.  Creating a link to a named anchor is a four-step process. 
 

step 1. Click in your document where you want to insert the new anchor. 
step 2. Create a new anchor point by selecting Insert > Named Anchor or clicking the 

insert anchor button  on the Objects (Insert) panel. 
 

 
 

step 3. Type an appropriate name for the new anchor and then click the OK button. 
 
An anchor point appears as an element in the Design view as a yellow shield with 
the image of  an anchor on it.  The anchor point is not displayed when your page is 
viewed in a browser. 
 

 
 

step 4. Create a hyperlink to your new anchor point using the method previously described 
in this document to create a hyperlink. 
 
There are two ways to format your link value: 
a. As “#anchorname”, where “#” is required to link to a named anchor and 
anchorname is the name of your newly created anchor point from Step 3 above 
(example below). 

b. As the full Web address followed by “#anchorname”, to link the visitor to an 
anchor on another Web page.  For example, http://www.csus.edu#bridge 
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EXERCISE 2 E-mail and Name Anchor Hyperlinks 

1. Open the file technews.htm in Dreamweaver. 

2. Make the existing text “questions@csus.edu” an e-mail link. 

3. Add named anchors before the titles “Copyright” and “Instructional Materials 
Accessibility Checklist.” 

4. Create two new text hyperlinks before the first story that links to the two new 
anchors you just created in the previous step. 

5. Save your work and preview your changes in a Web browser. 

 
 

USING TABLES 

Inserting a Table 
You can insert a table into your document by clicking the insert table button  on the Objects 
(Insert) panel or from Insert > Table.  A dialog box allows you to enter your desired table size 
parameters. 

 
 

▪ Cell Padding determines the number of pixels between a cell’s content and the cell 
boundaries. 
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▪ Cell Spacing determines the number of pixels between adjacent table cells. 
▪ Width determines how wide the table will be, expressed as a number of pixels or a 

percentage of the area in which it is placed. 
▪ Border determines the width of the outline of the table (the table border) – a border 

of zero means the border is not visible in the browser (a dotted line will appear in 
Dreamweaver but not in the browser). 

 

Modifying a Table 
After your table is inserted you can modify the table and cell properties. 

▪ To modify cell properties: Click inside the cell, then make your changes using the 
bottom portion of the Properties panel to edit fields such as content alignment, 
width, height and background color. 

 

 
 

▪ To modify table properties: Click inside the table then click <table> at the bottom 
of the Document window in Design view to select the entire table.  Make changes 
from the Properties panel to fields such as the number of rows and columns, width, 
height, cell padding, cell spacing, and border thickness. 
 

 
 

▪ To insert a row or column: Click inside the table and then click the Modify menu 
and select Table.  The Modify Table menu is displayed below.  You have several 
options to choose from. 

 



 Academic Technology and Creative Services: Spring 2012 Dreamweaver: Links and Tables   7 

   
 

▫ Insert Row will insert a single identical row above where you clicked in the table. 
▫ Insert Column will insert a single identical column to the left where you clicked in 

the table. 
▫ Insert Rows or Columns will allow you to insert one or more rows or columns, 

either above or below where you clicked inside the table (a.k.a. “the selection”). 
 

 
 
 

▪ To make other table adjustments: Click inside the table to display the table-editing 
visual feedback feature (green lines under each column and one under the entire table).  
Next, click on one of  the column or table arrows next to a green line.  Select an 
option from the menu. 
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Mapping Out Your Table 
Before you begin designing a complex table it is important that you map out your table on 
paper, especially if  you plan to use it to control the page layout.  This will give you an idea of  
how you want it to look and may save you time when you actually create it in Dreamweaver. 
 

1. Draw your table on a sheet of  paper. 
 

 

 

 

Figure 1 - Draw your sample 
table by hand 

 

2. Determine which cells should be combined (merged). 
 

3. Create your table in Dreamweaver with the maximum 
number of  rows and columns using the Inserting a Table 
process.  Be sure to combine (merge) the necessary cells to 
get the look you want.  

Figure 2 - Determine which 
table cells to combine 

 

Using Tables for Page Layout 
 
Here is an example of  mapping out a table whose purpose is 
to control page layout.  In order to implement this layout you 
will need to merge some cells after you create an initial table 
that has 2 rows and 3 columns. 
 

o You can control the placement of content within a cell 
(such as text, images or another table) by using the Cell 
Content Vertical & Horizontal Alignment menus or the 
paragraph alignment buttons in the Properties panel 
(see the section Modifying a Table). 
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EXERCISE 3 Table within a Table 

1. Open the file technews.htm in Dreamweaver. 

2. Insert a new table (1 row x 2 columns) after the links to Accessibility and 
Copyright. 

3. Split the left column into two rows.  Move the text for the articles “Sac State 
OneCard Discounts” and “Copyright” to the cells in the table in the left 
column.  

4. Split the right column into two rows.  Move the other articles to the cells in 
the right column.  In which order will you add them to balance the text in the 
table? 

5. Add a different background color to the cells for “Copyright” and “Merlot.”  
You may also add background colors to additional cells, if  you choose. 

6. Insert the image file images/discount_businesses.jpg below the title “Sac 
State OneCard Discounts.”  Set the image alignment to “left.”  Hint: you will 
need to resize the image to fit it in the cell. 

7. Replace the title “MERLOT” with the image file images/merlot_title.gif 

8. Save your work and preview your changes in a Web browser. 

 
 

USING SFTP TO COPY YOUR COMPLETED FILES 
 
After you define your site and edit your Web pages, you can use the built-in Secure File Transfer 
Protocol (SFTP) process to copy your completed XHTML files, documents and image files to a 
Web account – such as your faculty Web account, your SacLink Web account or your 
department’s Web account. 
 

 

 

 

TIP:  If  you do not organize your site files on the Web account the same as they 
are organized on your local computer, hyperlinks will not work and images will 
not display properly. 

This process does not work with SacCT.  You must use the upload utility within 
SacCT to copy files to an online course in SacCT. 
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How to define a Secure File Transfer Protocol (SFTP) connection 

Using the Site menu 
step 1. Define your site within Dreamweaver.  Please refer to the Dreamweaver: 

Introduction to Editing Web Pages workshop document for detail instructions on 
defining a site. 

step 2. After your site is defined select Manage Sites from the Site menu. 
step 3. When the Edit Sites window appears click your site name and click Edit. 
step 4. In the Site Definition dialog box click the Server tab. 
step 5. Click the plus sign (+) to add a new server entry or select an existing entry and click 

the Edit existing Server button (pencil). 
step 6. Select the ‘Connect using’ option as SFTP (FTP for SacLink account). 
step 7. Enter the information that pertains to your specific Web account.  Refer to the 

following sample image and table. 
step 8. Select Save to accept your changes or select Cancel to not accept your changes. 
step 9. Click Save again. 

step 10. Select Done to close the Edit Sites window. 
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Type of  Web 
account 

Remote Info 
label 

Text to use 

Faculty Web  
account 

SFTP Address csus-sftp1 

Root Directory 

/www.csus.edu/indiv/INITIAL/SACLINKID 

* INITIAL = the first letter of  your last name 

* SACLINKID = your SacLink ID 

For example, if  the name was Miles Davis with a 
SacLink ID of  “davism” the directory would be 
“www.csus.edu/indiv/d/davism” 

Username your SacLink ID 

Password ALWAYS LEAVE THIS FIELD EMPTY, when 
you connect it will ask for a password. 

SacLink Web  
account 

FTP Address Refer to the Connect with Dreamweaver 
document. 

(http://www.csus.edu/irt/ServiceDesk/ 
Documents/Configuring%20Dreamweaver%20to 
%20connect%20to%20SacLink.pdf? 

Root Directory 

Username 

Password 

Department Web 
account 

SFTP Address 

get this information from your Department IT 
personnel 

Root Directory 

Username 

Password 

 
 

Using the Site panel 
step 1. Define your site within Dreamweaver.  Please refer to the Dreamweaver: 

Introduction to Editing Web Pages workshop document, page 7, for detail 
instructions on defining a site. 

step 2. After your site is defined select the Remote View option from the view pull-down 
menu in the Site panel (shown below). 

http://www.csus.edu/irt/ServiceDesk/Documents/Configuring%20Dreamweaver%20to%20connect%20to%20SacLink.pdf
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step 3. Click the link define a remote site in the Site panel. 
step 4. In the Site Definition dialog box choose FTP from the Access pull-down menu. 

 

 
 

step 5. Enter the information that pertains to your specific Web account. 
 

 
 

step 6. Select OK to accept your changes or select Cancel to not accept your changes. 
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How to copy files using FTP 
 

step 1. To see both local files and remote files (Web account) click the Expand/Collapse 
button  on the Site panel toolbar. 
 

 
 

step 2. Click the connect button ( ) on the Site panel toolbar to connect to your Web 
account. 

step 3. Enter your password and click OK.  You should now see a list of  files in the Site 
panel corresponding to your Web account under the section Remote Site. 

step 4. Select the files or folders to copy by clicking on them with the mouse pointer. 
a. Drag the files and folders to the other area.  Be sure to pay close attention to where you 

place your files.  You can click and drag files and folders from the Remote Site area 
to the Local Files area or from the Local Files area to the Remote Site area. 

b. Put Files ( ): Use the blue arrow pointing up button to copy files from the 
Local Files area to the Remote View area (the Web account).  Note: It will 
preserve the file/folder organization and may ask you to copy the dependent files 
(images on those HTML pages). 

c. Get Files ( ): Use the green arrow pointing down button to copy files from the 
Remote View area to the Local Files area (the Web account).  Note: It will 
preserve the file/folder organization and may ask you to copy the dependent files 
(images on those HTML pages). 

step 5. To return to the main Dreamweaver window click the Expand/Collapse button  
on the Site panel toolbar.  This will collapse the Site panel into a single view, with 
the other Dreamweaver panels now appearing on your screen. 
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RESOURCES  

Faculty / Staff Resource Center  
Located in ARC 3012. Assistance available on walk-in basis. 
FSRC Website - http://www.csus.edu/irt/fsrc/ 

Training & Tools eNewsletter 
To receive email notification regarding online seminars, new technology/tools, and other online 
teaching, technology and learning events, fill out and submit the Training & Tools eNewsletter 
request form - http://www.csus.edu/atcs/tools/newsletter/request-form-ait-news.stm. 

Getting Help 
 IRT Service Desk  
  (916) 278-7337 or servicedesk@csus.edu 
 Academic Technology Consultants 
  http://www.csus.edu/atcs/contact.htm 
  1on1 Help @ ATCS on Thursdays 1-4 pm in ARC 3005 (no appointment necessary) 
 Service Desk - Problem Reports & Contact Information 
  http://www.csus.edu/irt/servicedesk/contact.html 
 Training Requests 
  training@csus.edu 

Campus Resources 
 Training 
  http://www.csus.edu/training 
 Training Handouts 
  http://www.csus.edu/training/handouts 
 Online Tutorials 
  http://www.csus.edu/atcs/tools/training/tutorials.stm 
 Educational Tools 
  http://www.csus.edu/atcs/tools 
 Accessibility at Sacramento State 
  http://www.csus.edu/accessibility  

Books on Dreamweaver and HTML 
 Dreamweaver CS4 Bible by Joseph W. Lowery 
 Adobe Dreamweaver CS4 Hands-On Training by Garrick Chow 
 Dreamweaver CS4 for Dummies by Janine C. Warner 
  HTML, XHTML, and CSS: 6th Edition by Elizabeth Castro 
  http://www.cookwood.com/html/extras/cssref.html 

http://www.csus.edu/irt/acr/fsrc/
http://www.csus.edu/irt/fsrc/
http://www.csus.edu/atcs/tools/newsletter/request-form-ait-news.stm
http://www.csus.edu/atcs/tools/newsletter/request-form-ait-news.stm
mailto:servicedesk@csus.edu
mailto:servicedesk@csus.edu
http://www.csus.edu/atcs/contact.htm
http://www.csus.edu/irt/servicedesk/contact.html
mailto:training@csus.edu
http://www.csus.edu/training/
http://www.csus.edu/training/handouts
http://www.csus.edu/atcs/tools/training/tutorials.stm
http://www.csus.edu/atcs/tools/
http://www.csus.edu/accessibility
http://www.cookwood.com/html/extras/cssref.html
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